
 

 

 

SESSION 2 
Edit a Poem 

In this session, students continue to edit the book “A Collection of Stories Written 

for Children”. As an editor, students apply their knowledge of formatting to 

make the descriptive words in the poem, “A Fun Day in the Sun”, look like their 

meaning. Afterwards, students learn how to insert a picture and format the 

appearance to make the poem look spectacular. 

Assignment 1: Edit A Fun Day in the Sun 

Assignment 2: Decorate the Poem with a Picture 

Session 2 Review: How to Format a Picture and Text 

Session 2 Skill Review: Edit the Poem "The Lion" 

Session 2 Extension Activity: Setting Page Margins 

 

  

Each TechnoKids project consists of 
6 sessions, which are divided into 
separate assignments. An 
assignment is an activity that takes 
about 20 minutes to complete. 

Learn more about TechnoEditor 
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Session 2: Edit a Poem  

GETTING STARTED 

Overview 

In this session, students continue to edit the book, “A Collection of Stories Written for Children”. As 

an editor, students apply their knowledge of formatting to make the descriptive words in the 

poem, “A Fun Day in the Sun”, look like their meaning. Afterwards, students learn how to insert a 

picture and format the appearance to make the poem look spectacular. 

 

Materials 

 Microsoft Word 2013 

 Microsoft Word Home Tab and Picture Tools Format Tab Flashcards (optional) 

 edited storybook file created by students 

 Storybook Sample file (optional) 

 Session 2 Review: How to Format a Picture and Text (optional) 

 Session 2 Skill Review: Edit the Poem "The Lion" (optional) 

o Poem template  

o poem edited sample file  

 

Teacher Preparation 

 (Optional) You may wish to view Page 2 in the Storybook Sample file to view an example 

of an edited poem. 

 

Teaching Strategy 

In this session, students edit the poem "A Fun Day in the Sun." Explain scenario to students. 

 

In this session, you are going to edit the appearance of the poem "A 

Fun Day in the Sun" on the second page of the book "A Collection of 

Stories Written for Children." In the previous session, you learned how to 

format text with commands on the Home tab. You will use these skills to 

make words in the poem look like their meaning. Afterwards, you will 

learn how to insert a picture and format the style to decorate the 

poem. 

 

 

  

For every session, the Teacher Guide 
features:  
 an introduction with a materials list 
 preparation advice 
 teaching strategies 
 lesson plans for each assignment 
 learning objectives for the session 
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Assignment 5 Edit "A Fun Day in the Sun" 

 

In this assignment, students apply their knowledge of font, font size, font style, text effects, and 

font color to change the words in the poem "A Fun Day in the Sun" to look like their meaning. 

Before you begin the activity, discuss the type of formatting that could be applied to the 

following words. 

 

 A Fun Day in the Sun  run  small  blue 

 winding  sparkling  tall  night 

 

 

 

Assignment 6 Decorate the Poem with a Picture 

 

In this assignment, students decorate a poem using a picture from the Editor folder. To do this 

activity, they apply text wrapping, a picture style, and then customize the border and effects. 

Introduce the following terminology: 

 

Text Wrapping: How words go around pictures 

 

Picture Style: A preset style that applies a shape, border, and effects to a picture 

 

Picture Border: The edge of a picture 

 

Picture Effects: An effect that can be applied to a picture to change the appearance 

such as shadows, reflections, glow effects, soft edges, bevel effect, or 3-D rotations 

 

 

  

This section explains each assignment for 
teachers and gives helpful tips. 
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Lesson Plan 

Assignment 5 - Edit a Fun Day in the Sun 

 Open the edited storybook in Microsoft Word. 

 Experiment with various ways to change the part of the document displayed in the 

window using the page down, page up, scroll box arrows, and scroll bar. 

 View page 2. 

 Use skills to change words in the poem to look like their meaning. 

 Save changes to the document. 

 Close Microsoft Word. 

 

Assignment 6 - Decorate the Poem with a Picture 

 Open the edited storybook in Microsoft Word. 

 Choose any method to display page 2. 

 Position the cursor below the poem. 

 Insert a picture of two dogs from the Editor folder into the poem. 

 Change the text wrapping to In Front of Text. 

 Resize the picture. 

 Apply a picture style. 

 Format the picture border. 

 Customize the picture effects. 

 Save changes to the document. 

 Close Microsoft Word. 

  

The Lesson Plan lists 
the individual steps in 
each assignment. Sam

ple
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Learning Objectives 

Below is a list of the learning objectives for this session. Students should be able to complete 

each task independently. 

 

Technical Skills: 

 

Operating Environment 

 open and close a program 

 navigate to a folder using a directory 

 open a document 

 change the part of a document in view using the page down, page up, scroll box 

arrows, and scroll bar 

 save changes to a document 

 

Word Processing 

 select text 

 format text using the Font command 

 format text size using the Font Size command 

 format text style using the style commands; bold, italic and underline 

 apply a text effect and customize the outline, shadow, reflection, and glow 

 highlight text using the Text Highlight Color command 

 format text color using the Font Color command 

 insert a picture 

 apply text wrapping 

 resize a picture 

 apply a picture style 

 customize the border 

 customize the effect applied to a picture such as the glow, reflection, or shadow 

 

Applied Technology 

 format selected descriptive words in a poem to make them look like their meaning 

 decorate a page using a picture 

 

 

 

Learning Objectives are 
specified for each of the six 
sessions in the project.  
A checklist of all objectives 
is provided at the end of 
the project in Session 7. 
Sam
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Assignment 5 Edit a Fun Day in the Sun 
 

 

Open "Edited Storybook" in Microsoft Word 

 Open edited storybook in Microsoft Word. 

 

 

Moving Around in a Document 

 
 

Use Page Up and Page Down 

 Notice the page number that is displayed in the status bar. 

 Press the PAGE DOWN key until Page 2 appears in the status bar. 

 Press the PAGE UP key to return to Page 1. 

 

Use the Scroll Arrows 

 Click the DOWN ARROW on the vertical scroll bar to move to Page 2. 

 Now, click the UP ARROW on the vertical scroll bar to move back to 

Page 1. 

 

Use the Scroll Box 

 Click and drag the scroll box downwards on the vertical scroll bar. 

 

Move to Page 2 

 Use your skills to move to Page 2 in the document. Try one of these options: 

o Press the PAGE DOWN key. 

o Click the DOWN ARROW on the vertical scroll bar. 

o Drag the scroll box downwards.  

Use your skills to make the words in the poem A Fun 

Day in the Sun look like their meaning. 

There are many ways to move around in a document. 

Read about them below and try them out! 

UP ARROW 

DOWN ARROW 

SCROLL BOX 

Illustrated, step by step 
instructions include tool icons, 
sample window views, and 
helpful tips. 
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Make the Poem Look Great 

 

 Make the poem look great. Use the checklist as a guide to make the edits: 

 title  run  small  blue 

 winding  sparkling  tall  night 

 

 

 

 

 
 

 

 

Save the Changes and Close Microsoft Word 

 Click Save on the Quick Access Toolbar.  

 Click Close. 

Format the bold words in the poem to make them look 

like their meaning using commands on the Home tab. 

If you have some time, use 

your skills to make some of 

the other words in the poem 

look like their meaning. 

To make the poem on the 
provided template look great, 
students apply text 
formatting skills learned in 
the previous session. 

Checklists help students 
make sure that they 
have completed all the 
parts of an assignment. 
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Assignment 6 Decorate the Poem with a Picture 
 

 

Open "Edited Storybook" in Microsoft Word 

 Open edited storybook in Microsoft Word. 

 Use your skills to move to Page 2 in the document. Try one of these options: 

o Press the PAGE DOWN key. 

o Click the DOWN ARROW on the vertical scroll bar. 

o Drag the scroll box downwards.  

 

Insert a Picture Below the Poem 

 Click the mouse BELOW the poem.  

Soon it was time to go home for the . 

The two dogs climbed into bed and turned out the light. 

 

 

 Click the Insert tab. Find the Illustrations group and click Pictures. 

 Go to the Editor folder. Double click the dogs file. 

 

Change the Text Wrapping 

 Click Layout Options. 

 
 

 Try each of the wrapping choices. 

  
 

Square  
 

Tight   
 

Through    

 
 

Top and 

Bottom 
 

 

In Front 

of Text 
  

 
Behind Text  

 

In Line with 

Text 
 

 

 Choose In Front of Text.  

Learn how to insert a picture, change the text wrapping, 

and format the style to make the poem look great! 

In Front 

of Text 

Text Wrapping 

changes how 

words go around 

objects. 

In this assignment, students continue to 
use the poem template. They learn to: 
 insert a picture  
 change the text wrapping 
 resize a picture 
 apply a picture style 
 customize the border and effects 
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Resize the Picture 

 The picture needs to fit on the page with the poem. To do this: 

o Click on the picture. Rest the mouse pointer over a corner sizing handle.  

 

o Click and drag in to make it smaller.  

 

Add a Picture Style 

 Double click on the picture. The Picture Tools Format tab shows up in the ribbon. 

 Locate the Picture Styles group. Rest the mouse pointer over one of the pictures styles. 

Watch the picture to see how it will look with that style. 

 

 When you find a style you like, click on it. 

 

Change the Border 

 Click Picture Border on the Picture Tools Format tab. 

 Click on any color in the palette to change the color of the border. 

 Click Weight and pick a border thickness. TIP: Often a thinner border is better. 

 

Add a Picture Effect 

 Click Picture Effects on the Picture Tools Format tab. 

 Try out each type of picture effect. Check off each one after you have tried it. 

 Preset  Shadow  Bevel 

 Glow  Soft Edges  

 3-D Rotation  Reflection  

 

Save the Changes and Close Word 

 Click Save in the Quick Access Toolbar. Click Close. 

Click the "More" 

arrow to see more 

choices. 

Sam
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Session 2 Review: How to Format a Picture and Text 
 

Match the tool to the task.  

 

1. J Insert a picture into a document from a file. A.  
     

2. G Set the size of the letters. B.  
     

3. B Change the border color around a picture. C.  
     

4. F Change the color of the letters. D.  
     

5. A Apply a text effect. E.  
     

6. D Place a line below text. F.  
     

7. C Apply a picture style. G.  
     

8. I Make the letters look thicker. H.  
     

9. E Slant text to the right. I.  
     

10. H Set the shape of the letters look by applying a font. J.  
 

 

Circle the correct tool in the group. 

 

11. You want to highlight text with a color. 

  

 

 
 

 

12. Shrink the letters a few points at a time. 

  

 

 
/12 

  

Review lessons at the end of 
sessions provide activities to 
check and reinforce newly learned 
skills, concepts, and terminology. 

Sam
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Session 2 Skill Review: Edit the Poem "The Lion" 
 

 

 

1.  Open Microsoft Word. 

  

2. . Click Open Other Documents. 

  

3.  Click Computer, click Browse, and go to the Editor folder. 

(Ask your teacher how to do this.) 

  

4.  Double click the poem file. 

  

5. Click View and choose Edit Document. 

  

6. Use your skills to make this poem look great. 

  

 

 
 

  

7. Save the file to the Editor folder in your student folder as poem edited. 

  

8. Print the poem. 

  

9. Close Microsoft Word. 

An important part of editing is making 

things look more readable and interesting. 

Apply your knowledge to make the words 

in the poem "The Lion" look great! 

TIP: 

View a completed 

sample in the Session 2 

Skill Review folder. 

Skill Reviews are activities 
for students to practice the 
technical skills learned in the 
previous session. 
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Session 2 Extension Activity: Setting Page Margins 
 

 

Setting Page Margins 

 

1.  Open Microsoft Word. 

  

2. . Click the Page Layout tab. Find the Page Setup group. 

  

3.  Click Adjust Margins.  

  

4.  Choose from the preset margin settings. 

 

 

Questions about Margins 

1. Why would a person want to change the page margins? 

 

2. Which size margin will allow more information to fit on the page?  

A. Top: 1" Bottom: 1" 

 Left: 1" Right: 1" 

   

B. Top: 1" Bottom: 1" 

 Left: 2" Right: 2" 

 

  

A margin is the space between text and the 

edge of the page. Most word processors and 

page layout programs provide a way of 

adjusting the margins. 

Extension Activities at the 
end of sessions provide 
optional enrichment challenges. Sam
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